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- ActiveX Server Components (ActiveX Hk 425 T4F)
BA T H 7tk. 7T ¥A4% A Visual Basic. Java.
Visual C++. COBOL%¥ %52 K% 5 H & &0

ActiveX Server Component .

- ASP.NET
- ASP.NET # R # = # Web m A # 5 % .NET

Framework -F4& iz 47,

Visual Studio

ASP.NET ] [ADO.NET] [ XML ] [ NETES

Windows 34 & &
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[ .NET Framework ]
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- .NET Framework
- ZMicrosoftéy #2 5 F &£ &, % #Visual BasicfeC#i& 5
# 3 ASP.NET# 5
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- ADO.NET
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Publicclass Class1{

Publicstaticvoid main(string[ ] args) {
System.out.println(“Good Morning!”);

}

}

. class: oA, AAEL—BARFRD,

- public: & 5% F T ABAE ERADEAR o

. static: HiF%%F %, main()FEA—ANEF K, Tl
RLAHERAR.

- void: A&-Fmain()F kLA L EE,

- stringargs[]: FO—AFHEEAGKME, LHITHEEL
main () Fk# 5, SREGATFHRALLLHET.
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import java.awt*;
importjavaapplet®; // 3| Njavaapplet & & 49 3£ & 4+
public class Applet] extends Applet{
public void paint(Graphics g) {
WEY AR VAR 3=
g.drawString ("good Morning!",25,25);

FE HTML A % AJava Applet

01 <HTML>

02 <HEAD>

03 <TITLE>A simple Applet</TITLE>

04 </HEAD>

05

06 <BODY>

07 <P>My first applet:

08 <BR>

09

10 <APPLET
CODE>="Appletl.class"WIDTH=300,HIGHT=300>

11 Ttis Beingtested!

12 </APPLET>

13 </BODY>
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importjavaawt.X;
impott java.applet.®;

/1A %

public class Applet] extends Applet
{

private Image image;

public void init()

{
setLayout(null);
image=getImage(getCodeBase(),"028_02.jpg’

public void paint(Graphics g)

g.drawlmage(image, 0,0, 300, 300, this);
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_ ApponHTAL — Nicowoft Visual J++ [tunl - [Appleti.jwva (Codell

o £ile Bt Yien Ereject Buld Debac Todls Tisdor By

= :n: Al b ualh Bt B ) importtjava.awtX; /73 %A %
L uw
=0 i 1 F.
w?}’j‘ mo TAD W S import java.applet*;
aea =) | O O WG Pux fromx @ue @ 2-5 B - e )
1 0) (10 Uy uccmentaWisnad St TrajestsgpenTHL el bon > LR Y public class Applet] extends Applet
e, s
o { ) .
~~ i A i ;g private Image image;
=] = public void init()

Y . setLayout(null);
image=getImage(getCodeBase()," L&k jpg");
}

public void paint(Graphics g)
- {

D J e }

g.drawlmage(image, 0,0, this);

__ ApponTRL - Rictoroft Visual J++ [run) - [Appleti.jwva (Codell LIRS
po Bile Béit Yiew Broject Build Debug Todls Zisdov Help =leix] E‘%z‘?
T R S 1 & R B RABIFTFHE: Java
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enee | - == i . Visual |++3 5 /v B 4 Applet
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A poret e

(1) # A B & 3 Applet
Java K % 3694 B T kAR T )'(/ﬁ:Graphics %%, Graphics
E @ JavaawtF, TRABIEFIANZAELRITFE,
Import java.awt.Graphics;
TVAR s 77 ik Appletd) 27 K F 3 B LARE %o

public void paint(Graphics g)

Dravl - Nicrosoft Visual J++ [ranl

Jrise Bt vier Bresect Buld detig Tosls Finden By
sa-ad B o-- o am

o w3 » e
o i oae] D SBD WED EEw TAD Shp ]
= o Fo - !
J& Projects/Webpages/Applet on HTML T & # £, o | Q7 - © - W @ G P e @un @ 2- 5 o e e
50 [Bm e e ] G 65 b s
impottjava.applet*; o e

importjava.awt.Graphics;
public class Applet] extends Applet
¢
public void paint(Graphics g)
¢
g.drawline(0,0,200,200);
g.drawLine(0,200,200,0); §
} ™

} DD § TN
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/] BFEH
import java.awt.Graphics;
impottjava.applet.®;

public class Appletl extends Applet
{
public void paint(Graphics g)
{
g fillRect(20,20,40,40);
g.drawRect(10,10,60,60);
}

/] &MEE

importjava.awt.Graphics;
public class Appletl extends Applet
{ public void paint(Graphics g)
{
gfillOval(10,10,20,20);
g.drawOval(50,10,20,40);
}
}
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& R4 B RATRIF T Java
/I REEFE
impottjava.awt.Gtaphics;

public class Applet] extends Applet
{ public void paint(Graphics g)

/I BREWRE

impottjava.awt.Graphics;
public class Appletl extends Applet
{ public void paint(Graphics g)

/1 BFERE
importjava.awt.Graphics;

importjava.applet*;

public class Appletl extends Applet
{ public void paint(Graphics g)
{
String myString="Draw This String";
g.drawString(myString,10,10);
}
}

21



TR TR R T P
[Lile Edit Yiew Eroject Build Debag Jools Findew Malp E.%;&
LT BT VeRe b [BERQ s - 27 MG ELRIRIFFTFH: Java

e

Wiy wHw 6Rw RO Inw loma - fEDreamerWeaver F#]4E M R it 4&4EJavaApplet:

S| O W AG O s @ue @ -0 B - Bewd 1 peo

40 BTar s e T (1) f£Visual J++ Projects/ Web Pages/Applet on HTML
i AT — A B L
PR v (2) # 3.4 HclockjavadyJavail I A
(3) Debug/Start)s % m.clock.class
WA B T 9HTMLI A4 Pagel him® A S H AT 5
clock.class A % 9 HTMLE AR A, 4o
<p>
<applet code="clock.class"width="200", height="150">
</applet>
</P>
" (4) ¥clock.class fepagel htm#% N %] DreamerWeaver T #]
AR R R PTG B KT B )
(5) # MR kL Epagelhtmpkdk,

E2rT

Wicroxoft Visusl J4++ [desien] — [Clock?. java [Co

sl

o 8 . B - N R o
. Ty ——
. ) (= resrermm ! e ~| CE——
Dtet e e Catrls | | I o tiwE 8 bt e 1 Gt | R
Hpems o i . -
5% croe Py e dus 1002 atands kol implents hanile Tz e e o vz = Lot inplements Busnible B satutin“clead 0 30
Thread tiner = wall. - 2
R Fointar T Y Taa i s 2 Clock2 java R Peinter 3 b To Corsar CurliFil fasm, JastyesD, Tastshad, Lustysan, N
Bate mew ate O xwplel bl
o= ey, tLacal Steing ) B Riseuttamoes Tiles SXsup Do i [
e it 0 R m
[ A Gl 255, 255,255)) Culr 255,255,250
rerize o BT et ek windwe size S Add Barch Shi Fre 7 S0t elesk windew size
8 Tusert Beeriat
ol o 8 s 0 i 8 it ity v 5 dnras ot v
4 Claar 11 Brasipoints CieltShi 470
e i i e 0 in 3, 5 i, G O - pril PRI
& drwrLine (0%, yOby, 0%, yOby) ¥ B : # 4 B
£ aantine G0t 300 3005 Jove) Clia U 3 ; pe
€ drwrline bOby, YO x, x0%y, y0-x). - + - =
fEmmEne e e
P e o 675
Sl 0yt 0 ] - = |
& EwLine GO-7, Y0t 30-7, 300) B Tuea 1 DETN

P —

Cirsle ix sust Brasesban' s algor

i wid circle it 30, im0, int v, Grapdics ©

int xy
ot &

™ Chapters

Untitled Document (Chapters/Test-Java-Clock) — Droanweaver

fite it Viee Dt Selify Tt Cwswds Site Tinde ¥p

r— #.0.[Cc wim,

TR MO KW SRe IAD ERy
] O WEAG Prex foms Fus £ s B
i @) Studis heal v Dol uF |

™

@ KRS 2AKNG B

wos4B A Tz

The source.

eI
2 4|




(Chaptor6/Test-Tava-Clack) — Dresmwesver

et et Belify Tost Communds Site Yindeo elp

ti1led Decament #.0.|C oo @

B LD ]

vAL g

S
BT [Bocmet =] Toslovatick

dEE

T e ywo 0 w2 Ciock Reskmgrie 34QY ] AW [Brcem vt 2| 2 + T ey 59 s Cock simgie 3 ] A0 [Erovem Cotus =] ’z -+
ol CL QL M I s | CLI QL M | .
20— Ez3 oo oy >

oot ovier vt 20 o0 Camer
o775

TG  Coaprars

Untitled Docusent (Chaptect/Tast-Jxva-Clacks) — Dresawoaver
el 26t Vi Dot Beity Tt Commnis Site Yindeo By
O B | riaa ot e cmant #.0.[C w0 @

DA Clock - Nicreseft Intermet Explorer
WO MED EEO 4We IRD *Ry

o Ot - © X @6 Orx droms @us @ (3-15 B -
01t 01 (Y- \CAE e xa\ChaptorBh el ockhmmmpl et iinl Y BeE ws
iz
.

205¥4H 08 TFod:se08

The source.

8-4 it HIHAN
FHRRR—ALTARAGHRET K, BT LTH AR TLRRF RS AR, R P H ISR 2 AR
F F GRS T RAAE CRFRBELES R BT I F SR A FBATH I A R IR S

B CECEE-R QU R IR B S

. R H 473 A (Parallel Computing) « £ X i+ H (Distributed
Computing) #=®M#it+J (Grid Computing) % J&.

o B IEA ) — ANEILR ARFR LA P ARS8 R KA PR
FoHERRAIR S, AT =S R P T ALAEAT b5 AR
AAERE FAL Ipad 4 EHE R 4K BT E 69 KA RS, A
mRENESEE. RETGIRS S, LATHF X E M

1% &

TR IR

= axany




. B RHE
- YFT RAAAR LML, “deGooglexit L 2 2MAL1005 5
RSB, “F7 RIKT AP AR GH RS .
. B
XA P AETEE. MR SRR R B TR R
BORS, EIRSBEERT LT & R4 BB M SH A
B AR, P RER S B AR R 69 IR SR AR .
- BTN
- YET R T HIE S SRS I SR T LB kAR
BB 409 % 7T ik, AR &3 S oAl A AR SR A T 5

» N

TR AT IR

& T4 Gk
- ET QMELT A ARG, R e B AR KA E K.
BEMRS
- ET RARKRGK R, BEEREME, KA KK &

Folk K —HA R

LI R
- BT O ARG AALE RARIT TR A RE R B, RS
= B REETEREANT ET R AN AR X867 5, H K
P T F 2 = P R KR AR S A b, PR

W KR A A A 69 B B — RN

TR ARG R4S

U 5 IR S5 SRR gy Oy = Bh ek Vi BN OIR %%
(CInfrastructure as a Service, laaS) . “F&RIRS (Platform as a
Service, PaaS) . #1HRIRS: (Software as a Service, SaaS) .

KAEIRS (SaaS)

z F & 81 % (PaaS)
k#ﬁﬂﬂ](ﬁﬁﬁﬁﬁ)( st ) (mAmsE )
LRIR B (T0a5)
(Ramae ) (anAem ) (AHRXERERE )

ZHER
&mF%ﬂ)(ﬁéEﬁ][ﬁﬁ%ﬂ)(%ﬁ%ﬂ)

B
<§%7 ( /R B

T EY AR B 25 B

- PaaS

- PaaS/= LR BE R P AR T A ABATHIRIL, FRA P %
GAedpE R TRt e R MRS, HAES R TiL L
BB AL S E RS E TR T, PaaS” & @ %149
AP AFEAAR. A 4 PaaS* & & 4 Google App
Engine, Microsoft Windows Azure ¥ % 7 & #) Hadoop
F=Eucalyptus. & F =3t £ 49 BIMIR 4 % 3% & /£ PaaS
F& L Z AR

T EY AR B 25 8L

- mAEEAGDRRAREANATTH PO R ePRE, Fi
WA AE R =ER@E AP AFHREE.

. laaS

- laaS/” &b 53 A P 7T VANBE B 7 AR 45 AL JL 3t Ho Ao
BAEFTRAEBA XA, FR A LA 69 FRAT R
s Al B A 89 TR T e A4 YA TARSR
AlaaS#EH 7 . A K &M d9laaS > & % Amazon
EC2. IBM Blue Cloud. Cisco UCS#=]Joyent, laaSiR %1
i8R, AP T AREEAT A TEZGRSAm A, 12
TP R 65 o T T M 5 4 38 o )
Aot iz B

. SaaS
- SaaS;LA5 ¥ Bl K TWebty 77 XBAEL R P o Edo,

Bk R R A, A= RS SR, A
MHERFEPRZERFRLN, AEMEHM4FRE
4 R F B R Ao A 4 SaaS F % &
Salesforce.com # £ &%, % P % A % # CRMJR 4, Google
Apps. Office Web Apps #» Zoho. SaaS# Lpfkik, R
By K—R PR LIRS
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R ED B R LRFARLENISTH 2L, =AXHE.
RAZ. REEAITLEZGFH T Ko

- M=

- AHEAHIARITL FIRS, e L RIE R KRR,
o B ARBER Y, LERARIK. AHEHFHEHEE, &
TN AL A AR EAT IR B3] it AR R FIT F R 09 %
a. B BEAYY.

- FBITE X¥H T AH =M%, @iFAmazonigAWS. Googled)
Google Apps #=App Engine ¥ % Microsoft # Windows Azure.

- ARERAMBET AR WA RERARLD, T
RAET R AT B 5 HAE T B2 R BT
Hpo N =B LM AT e @Y, AR LR —F
AR, WHIRA TR LR X BRAAER R G TR
oy, FMPERS AP, AR SRR R,

- BHERESLAFREZHL GRS EATE, ALLAZR
RS, DLGITAR G o 438, wehfRESR T
HATA A H

- Lt bl bk, A ST ALENE REG R
i, BRITRM G L 4E. RAZLIZAARBKE: L —R
IBM 5 3t &4k 4k 4, F 23, #91BM Blue Cloud (IBM. # =)
#2IBM CloudBurst; f —;2VMware. Cisco#=EMCZ4L & #9VCERE
3, 24 Cisco UCSF=vBlock,

- BAFHRFOERELE, REFRELZEZHERMRA, Ao
AR IAT R KR, XA R Ao 3R LR AR v 4 Ak LA
HITEZARFAR ., TRAZILAETRAS, GHEWER. 2
PR A — RN BE Y GAN e FEHN, BAEE
Fo LA o JEFRARKE — BT A, AR =R A KPR

- BEE
- RAEFRRAA ZABH LI —ROBEX, FiFbLIFE
Xty RAHFHNREY, LR ERG. FXEOE
SRR E R AR FGRA = L,
- RAE TSV RFE ZBEAE G RE R RK. R
SE G RERRARY, R FE Y, 2% Amazon VPC
FaVMware vCloud, {2 € 4149 45 b Ao s AAR T 45 248

Lol Zil LA Z X

c fTL=

S AR R EINTALE AT R R SR e R, B A LR
%747 b A A fr Ak Fa R
AThEHERMKAH T, B K EFSMAATLFO BT T
A A R BUTR T SAT et REE, A BEAMTLRE S
HRIFE GRS, fedt—F AR F R, B A, 1247
Axg LHFER D, APpEDN, AT EmE, HARFF
He oy AR F

TR QT TR
AHZE A= BEZ ik z
H BA LGN EON B8R
ks (P fRA R B B
i3 R A5 # R
Homarfet: # RaF I Lo
pLiiEa s RXHF XHF XFF AT
R FRRA EAidot TSRk Rl

o 5BIM. BIMJR 4269456 JF)
- AT &3 A HBIMEIES A XAk B A

o BaE AWM X H M AA S XA R K
PAREBA, &5 LA LBIMEIE Ao 45 # 1L BIM 335
W oA XA 7k, MAATR P XBERG=#
BIM 048 & 44 5 34 240 09 8 sh AR, A
R R, AT Fi L HBIMEIE A XA
PR A 2.
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UM EAR T AR P S A

- AT & e oA ABIM#IEE E b
o HAFH A KB — B LY ST R
Bt WA HAB IR AS F A, I 4 A5 49 BIM
BB, FRBIMMIE 0 — A s, HRFHEK.
HAB S FARA G SR FRBHA LH.
- A ABIM#$REEF X

o 2 4BIMAK R A, 3 X A R BIMAIE & 44, o8
IFC#% X A2 & A2 JEIFCAS XAZ & 09 Atk 54, o A =3t 5E
8 57 XA AR = HBIMBIE R (4 2R 45538
Ao BN MR EVHE) , FRAAERHEFS T
F. FMBIMAIE 8 oA XA Ae b — % 22

T HELR TR P A

s 2 F =i HBIMMR 5Bk A £ H

e &
L] § /{ Tmﬁ

=

e -

semIERE

Ene i Ly *‘

ST HAEAE TR P A

s R T2 ENBIMRSEFE4HM 5 294
THEER = = ,FC@#
3

LR TEGEE GHLTERR
FIFCHERME IFCXH
[HEIFomﬁBlM?ﬁﬂ] [ T IFCHBIMTFHRR ]

- H?!x i X i

BIMDISPF-&

SR E SRR |
(
AT RBIM
B
iR IR P LA

« JEIFCH XfF Bdbfeig m:

v iR B e AT JEIFCHS X 93DAE R . 31 %) A AR

RAFTAREE, ENAETHLELAFCHEA,
o TR HAERER:

VAT R AT S RAR I T FIBIMAIE A, LE
BIME 42 69 3R B SR AS 7, F) BEARSE R P AR IR 237 19
HATE R, IR SR PR A R8BSR
L YA B — Bt

o JEEEME EE B

VATFEHEFSREGE D G e R
R, TR E R E GG F AL, SR e BT
0 AL

T RELR TR P AMA

o FAREAAMEZ XA
v TARYER PN SR B K, KR TIFCAKAEREA
FelFCFHE R 2 R AL B 50 AR FHEBAE, AT
o FRBRIBEL:
v OARIE PR SA K BE K, oA KBIMAE &
AR P RRBTE 15 B
o FHEA K MAE:
v ¥R P4l BIM AR R 3] #KBIM b, f £
oy LR
o IFCX A7 5.
v g BUF R Hrstep Rifexmlg X A9IFCAE, £ W A F

3 3 K FIFCAYBIMAL A .
iR AELR TR P A
os 2 F &3 HWBIMR 58 5 AAEX,
wgh ﬁ TR
f i i
FOBIMISP RS B BIMISPRS W BINISPRS

B

BILSPF & g

2 RBIMECH i

AMMBIOSPRE
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o BT RMSRE 85 H X2 HBIMEIE R B AHA | BT RHRGSH LA HBIMBE — K2 E 2 b
/AR 52 HBIMACIE R 25 B 2 RSB B S AL 7 HR P RATBIMT R R AN Kos K5 HBIMBAES
RN E A, %3S BRI 5 B, BIMISP 7 5t 41845 L SCH LR 41 IR 2 9 5 L b
AR A . R L6 2 HIR A4S E AW A S, AT 6 4% e
HAREAA 575 5A8 09— IR B PP s—F 2, % FI#H, FRIAE KR —BBRE Y LN, AR
A7 #BIMALIE 9 8 1.5 Ao B2 MBIMBHE ) — 5tk

o ETF oA X = mBIMEBAE R RAERBUE SO 2B EA
v BF R AT U4 3L A Ao MapReduce #9 BIM F 42 A 32 B
EHDBER, FAKFRPIES S MARIAT
1E%, TS 2 BLE @A P E RIE T EMAT,
ST E 4 A P ik 35 P % 49 BIM .

LIRS

& g5 mwmsEMRETFL © 45 R FHUBRTE RL LB

BHEKR, RARBHEARA LR F 458
R, RA

500 million apps downloaded.
And counting. d) \“’

Symbian OS SDK3z#5 IPone OS EFM Android#JZ7E Linux P9#%

C++/Java FF& Objective-C Android SDK # Eclipse
M : UIQ (OSAS. XcodefEmiFFAF IDE

EFREE ) JavaFF RIES

””””””””””””””””””””””””””””””””””””””””””” J2ME
. KA C++, Java, i S60, UIQ,
SYaki=n Ovi Store Cas Python ~ SYmbian  WINS yopp, qt
>\
S sl AR A c++, c#,  NED Windows
Windows Phone A C++ ’ ; J2ME, VSHER  ER,
. Marketplace VB, Java 3 A "
i Symbian WinCE API Silverlight
Symbian ARM, x86 1994 Symbian~3 Foundation TOME
) 4 BlackBerr
) BlackBerry App World C++ Java Blati(PBIerrv H VE®
W;r::“;"s wince T AEH MRS 2000447 7.0 Microsoft & @ c c
” = = " = " ocoa ocoa
iPhone OS App Store Ob]egtlve- Objective-C Touch H Touch
BlackBerr % = ARM 1999 6.0 RIM . . .
Android Android C, C++ Java Android # Android &)
iPhone 0s [T IS ARM 20074 15 3.1.3 Apple Blacket Eayalciass *
BHa (o} C, C++ Palm API k- PalmBE
Android Linux 2 ARM 20084 107 4.0.3 Google G @
K, ERE HTML, webOS webOSH
% 5 ARM 1996 5.5 Palm © JavaScript, APL il #
Linux 4 ARM 2009465 1.4.1 HP AJAX
I";ev'i‘;‘:p:’ep' C, C++ C, C++ MeeGoAPI % Qt
Linux £  x86, ARM 201043 1.0 Intel, Nokia o
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2009 B B RIE RGBT LA

AndroidwebOS_ 3t
1%

SELinux
5%

Windows Mobile
9%

® Symbian

™ BlackBerry

¥ iPhone

B Windows Mobile
B SEdLinux

B Android

= webOS

)

FHIRTER RO T IZIHEN
Worldwide smart phone market
Shipments by platform, full year 2011
Full year

2011 Growth
Platform shipments Share (%) Q4'11/Q4'10
Total 487.7 100.0% 62.7%
Android 237.8 48.8% 244.1%)
i0s 93.1 19.1% 96.0%
|Symbian 80.1 16.4% -29.1%)
|BlackBerry 51.4 10.5% 5.0%
|bada 13.2 2.7% 183.1%
|Windows Phone 6.8 1.4% -43.3%)
|Others 5.4 1.1% 14.4%)
Source: Canalys © Canalys 2012

20115 2R FRFIUERE

o HR—FT

o BHELTHSF

o ATHRELEBERENEA
e HRIREERE

o BEYRMREZLETE

XA L5 Rdm kit

,, LT

oo

E0E

(5

Android % & JF £ 69 B X

% HEESERD

G FHH a5 B
- BT, EE
LTHIYEE
(87, 2% B%)
ShEaTEP FiE

e
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AndroidFF & sk

Android #F RANBIERIE RS, Pl A— L OCH N .
Android &3 TIAVAIK RS, B4T7E LinuxW % E.
Android SDK #2422 F & BT 2 1) T A5 APL.
Android 7 & 3R 365 4% &

O A A AL S 42D 3DAF (OpenGL ES 1.0).

) SQLitedk 4 45441 535 -4k o

B BRI HF ST AKX

@ ##3 FBluetooth, 3GAWiFi

B ZAFBARM. GPS. A5 d4tAehn it EALF A R B804,

© F&GTFRAIE. M. BRTL, NAETHRN, ARA
Eclipse IDE AT 5 9 464+ o

AndroidFF & sk

e Android# R 2
WA REFARRS, FROFAIF TR
KFQEMU FA BN B FRF AL THFF.
Ty T EH BARIE T B 69 AR R GO AR RAT IS B
o Android SDKF#f 3 ##9 & 4L3R 3
Windows XP (32-bit) or Vista (32- or 64-bit)
Mac 0S X 10.4.8 or later (x86 only)

Linux (tested on Linux Ubuntu Dapper Drake)

AndroidFF & sk

v Linux Kernel

Android & FLinux 9 4%, 12 R A&Linux

PR R GRS IRS, AP, AAEE. #EFE. KL
B IR 4 o

R @3 43 49 Linux,

P A I 0 RN SR R 8 SR K A 0 — AN R R A
BAE R R A db A Ae AR O Ao AT A9 Linux R RA PR R A o

LINUX KERNEL

Binder (IPC)

AndroidFF % 47 ik

e Android# 4t #
BRBRETFHK, RTFFEAARLFAGREEAR T, 2T
BIFEARGHARAKT, AAFFLE ZREFRGE
KT AA RN A B ACPU 44 it &9 & MAtDalvik, Android
093847k L R0 B S
MRE R PR, BEWMO KRS LHF, &k f0 k.
RAFEG BAVEX, FLBAKHGET: BET. HEH. Ry
E AT AGRAF A A B o KA S 4R340 IR AT A R AR )
BAET, WMKRARA T R e .
Android #9 4,75 it 4% Apache V2 #4345 7T, @ 238 % #9GPL v2
#T, AHATRLFL.
A% K eLinux 4 K £ #.

LINUX KERNEL

AndroidFF & 4 ik

v Libraries

#&-#bAndroid 2844 ) 8 38 2 AR AR B2 F R AT AR Ao ik,
2R e

- 4t4kJE: MPEG4 H.264 MP3 JPG PNG ...

- WebKit/LibWebCore: Web i % 3] %

- SQLite % 7 #4% % 3| %

- 2D, 3D BW . 3%

LIBRARIES

Surface Manager Media SQLite
Framework

OpenGL | ES FreeType WebKit

SGL SSL libc
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v Andoid Runtime

o Hou B ARAE 8 ]ava I fkDalvik & LR # T Linux A 4%
=T #3547 % ADalvik f S
4 —/~Android i 425448 E B T é9Dalvik VM 324 & i3 47VM AT
g Dalvik T #1474 (.dex)
- fegpiFitag)ava 4 A dex 4

ANDROID RUNTIME

Applications Framework
c HSEA, BleBRAA, BFEAE, wiE, REE, B85, kA,
o For i F BT R ARG B R AE R API

AL 69 F
© Mavath 5 p AARA
APPLICATION FRAMEWORK

Window
Manager

Notification
Manager

Activity Manager Content Providers

Tele

Package Manager ,,,mm)}:" Resource Manager

v Applications
- JAVA% B 6 5 AR

APPLICATIONS

AndroidFF % IRBeah #5328
o BAFIF BT Bt

- #EJDK
- F#Android SDK
- ft % Android SDK
o BHLRERGQHE, RAERE->HA, & FREE 4, SK
“AH%EF” FT®wHPath® ¥, FeAndroid SDK tools#y Ji 55442 Ao
A4t (4oD:\Program Files\Android\android-sdk ) . #Aw %5,
T VAR 4447 F A 440X android --help, 4o % i #android 49 #
By AR BL BT T o
- 43 MyEclipse(FF £ 3 3%)
- 4% ADT(Android Development Tools)
« /3 #MyEclipse, Help->Software Updates->Find and Install->Search

for new features to install->New Remote Site. £k J& 4 Aname: anroid
(Ffi42) urlhttps://dl-ssl.google.com/android/eclipse/. #git ¥,
Re 4. R ZHEE, EBMyEclipse.

v Applications Framework
c BSEA, BleIRAA, WM, Wik, RS, A, XA,
A BTA A L AR RAPI

o e E A

- Mlava %5 g AR

APPLICATION FRAMEWORK

Window
Manager

Activity Manager Content Providers

Package Manager Resource Manager

v Applications
.« JAVA% 5 & 5 A2 A

APPLICATIONS

AndroidFF & sRe ey 3532

o BAEZR

- MM AVAECPU, 2GA LA A
o BRAFZR

- Andriod SDK

- Java#r3%JDK 1.6

- Eclipse #= ADT

o BAPF BB
- frmyeclipse Z fic. # SDK#%-12
- i 4#Windows->Preferences->Android, it#+Android SDK#4% & (
4eD:\Program Files\Android\android-sdk )

3 Preferences [
Android =i VOV,
Geueia Android Preferences
Android T
ot SDK Location:  D:\Program Files\Android\android-sdi Browse...
Help Note: The st of SDK Targets below is only reloaded once you hit ‘Apply’ or ‘OK',
Install/Update .
i Target Nome Vendor Platform 491 -
Vog b1 Dasdopriai Android 233 Android Open Source Project 233 10
Run/Debug Google 471 Google Inc. 223 10
Toern DTS Add-On XYOCERA Corporation 223
XL DTS Add-On KYOCERA Corporation 23 w0
DTS Add-On KYOCERA Corporation 23 10
DTS Add-On KYOCERA Corporation 23 w0
Reo3DAdA-On  LGE 23 10
Real30 Add-On LGE 233 10
K12 Sony Ericsson Mobile Commun 233 10



https://dl-ssl.google.com/android/eclipse/

o BRARIRILEY 5
- 434 3 #HLAVD (Android Virtual Device)
- it #Window->Android SDK Manager, % JF# i 69 4 ¥ it 4 % & 49 SDK
Platform#= 3} i #9Android APls, #/&sktlnstall Select. % # % /G4 FH.

L —— [E=rEr=>)
Packages Tools = - |
SOK Pathx D:49rogram Flesihndroidiand
Packages
 Nome A e Stews
41 Android 233 (471 10)

+ SOK Platform 0 2 Birled

& Sompies for SO 0 1 Blestalied

& Google AP1s by Google nc 0 2 Biesled

§ DTS Add-On by KYOCERA Corporation 10 1 Binsaled

% RealJD Add-On by LGE 0 1 Blestalled

% EOK 1.2 by Somy Erceson Moblle Communic 10 1 @ imstaled

Exras

8 Took 5% package 15 Birslled
Shows IUpdates/New ¥iestalled [ Obsolete Seect N or Uit
Sortby: @ 490 level Repoziry

.

Dore loading padkages.

o« RPFIRILE) IS
- 4] 3% & #24LAVD(Android Virtual Device)
#4#Window->AVD Manager, # i &New, #HERKBA. ZRE, LR T
BArT. £k, RETHE.

(5 Andd Ve e Manoger

oot it v paraer
||| AvD Name Target Name Fatiorm 491 Level CPU/ABL New..
|| 230300 smcia2ss w w A ) g
| \ S v = Dee-
|

Nara 23399

e
| O s
e =
s
i
=

||/ & valid Andoid Virtual Device. ) A repairable Andeoid Virtua! Derice.
X hn hndroid lowd, Cick Detaiy

AndroidFF % Hello world!

- 47 JFEclipse, it#File > New > Projecte %Android #)Eclipse #9 45
HIEA AT, B a9t iEE 23k & A —R “Android”, it#E
“Android Project”, & TF—#.
- BT ek, HAT R4 A SHelloWorld, X 2 H5 e9Activity
names#t &R 6957 B 4] 2 4F G Activity 49 £ % o

£
¢ un- Soure. Nargute: Search -Project - Refocior Wedow, Help. m—
=84 868 B BN 9-0-Q- F@- ¥~ 7

package hellovorld. naee

# taport androld. ap

AndroidMarifestam! package helloliorld.namespace;
progunisly
prejectproperies inport android.app-Activity;[]

public class HelloworldActivity extends Activity {
Called when the activity is first created
@override

public void onCreate(undle savedInstancestate) {
super .onCreate(savedInstancestate) ;
TextView tv - new TextView(this);
tv.setText("Hello, World!");
setContentview(tv);

AndroidFF % Hello world!

Android

2:50.

Saturday, March 24
€ Charging (50%)

31



- http://www.apkbus.com/android-830-1-1.html
CEPF 5@

=5t : Android Timer itB52
=+ Hif : App Widget A HERS

esiofile
AN B3 : Android FULSEARIIAL]
=Lt : AndrokHEREZASIFAC]

=M : AndroidiBE TSNS
SEEHH < Android WisSsEEAS)
SHFH—1 : Androld EFEEAC]

BPH-Fi : PRE View (+=

M- - M View (+=)

=\ : Androd FSRMATFBAFEAS

8-6 o BE PR A

“HB A" (Intemnet of Things) 1489 R:EH1Z &4
BRELIRMESR ARV RH—AEXRL, &
A RACIRA Fo B 2o

W BRI XA R

WHER L LKA

> LRI S R T

> DN O LT O 5 A
RHAERTSE, £ YR BRK, “DEHERFH
#yE ‘BMMIBERT ELHH—H “ELEAL
AR AW R B AN Rk

BAR %Y, Hdiessitss TR, mAEAN TR
R AT ALY 8 B IR fel B AR Y

~

"

N

YR PR IR AR

L/ RES S
> &EmERRiR: FIFRFIDIRAE . KM i v 4577 s
AR ZHATAR IR

> HAEM: FIHRFIDFEE ., KA. R, PR,
Tige, B H e R MR B B I B . B B B R
EXFEER G, A

> WERMEE: FIACUKM. B 53 R a5 B
AT SR ARI%

> RS xR S DU REAL R R, SRR BIA
5YaiE .

Ay B PR IR AR R
LR IR E TS
> FEBUB G ML FORRESTERTM, /20204, it 5 4y
PrEB S, RS NBEME S, KikF30t 1,
[RIE,  “PIEM " BERR R F— A LR EE S .
> «Internet of Things in 2020y 4% & 5 AR, K RHIFER
W K 22 5 vg A Hr B
v 20104 Z ATRFIDAR S~ 2 B A F i B A ) 2547
v 2010~20154 41k A3
v 2015~20204F # ki N5 ik A
v 202042 )5 PRI N A AT AL

R PR IXAR IR AR

LR
MR LB ZRRM: B BB MR B

AAMBAN MBS WRAN  WREM  WMAR S MOGK TGNK

g | S EE R
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http://www.apkbus.com/android-830-1-1.html

B & R

CEe TS

T8 BERMBREESOA) MEKRERRO (B)

=% BRSPS TR O

R A BRI R

WM 6 XK

> PRARTAEAR
v R
v KA
v RFID

» BEBAR
v ERBHAR Bl TR E
v REID& e K A7 fk 200
v ME R % (MEMS) @ RERF &

(=
Y wmRABAkmE
YL H) REEH AR
> FSER

v REAEBERL (WSN) HA
v Wi-Fi (Wireless Fidelity, . £ % JL # K)
v ifE M. ZEEF. 3GH . IPV6
v GPRSF % (JkTGSM # 4y L& o X HAR)
v e, NGB (T—&K/ #eilm )
- BAbEAR
v 4k KRR (ERP: Enterprise Resource Planning)
v R A% (Expert System)
v ZitJ (Cloud Computing)
v A4 (System Integrate)
v 47k A (Industry Application)

< KA BRGFRA S

Jo AT W T By AN AE & R SR A B 6 BT A Ak
T, AR AT R A AR KA S8 T AH AR G SR ke
¥,

© I (hEF. G KR 5]

© AFRFHA (B M 8 Fe o)

CORRHAR (R SRS B0, BARAE R B /OB

HA MR AR, AT, FAE)
CORRIEAR (KR, M. B ER)
© R ARIGHHEA (BRI, HS AL R )

v GPSIGISH. A 4RIz ITlE 87 %
@&
- I ARIRIRA
KEFR
- REHA (RA) R4 DIKGE—IFR, O —BLTFFH
PoAmMR, BFHEANFARN. 42
- REHBEGTEN:
o T AR IR — AR
© RS LA GiRR), A Ae A
< hebedon, R R, ETF AR ER, TABBER
o IR EAAR AL, ALK, RSAMHE
- R RBELT0HR405K, A5 HeE A RREE
R A 2041
TN
© My TEATIRIEAR

TR VMR
EAN-13 1234567890
- EAN-8 Jm i A i
_ UPC-A LHN MM S RORT Rewry A
UPC-E [ :
HMFAR it
- RREER = Wi
128% ;
- ISBN/ISSN mm;-i-n 9012341567892 |
P kS
i i
& 2
oillo12735 4567 89l0ls
ﬁ ANEE EWRE *

Bt
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P HERIRIAR
—HEEAHAR ‘#ﬁ:.he %% A REIRA B A
PDRA17 QF BRX (LE. FHAFBENE) AERRZ (CCDRH
g2l tﬁ"ﬂ&
QR Code(f i EN & x-F1 )
1992 & 1996 - » . ) @
o B 4E W) B R X FHX
Datamatrix# Maxicode QR Code BERRAFHEK
Maxicode 2H XfesHX I
B e e 14E e
U | e T um
T >-pem E
BN -
T o TAREER (FK)
\ :'J’..:j; SR/ FEE R
R
- BAREA
pdf417 R
P ERIRIAR
- RFIDEAR - RFIDH R4 &
Radio Frequency Identification, 3738 % 2 —#b dE 4 fik X 69 & Peik 42 b
AR HA, BRI 5 B 3B B AR R 3K B X 5 BB, HIK S A
¥, WA THERFALFR, TIH,TEFESA L. TR T G b Sy Aol AN TR
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